
 

  

 
2018 Knowledge Based Nontraditional Engagements 

March 2018 

CCH® ProSystem fx® Knowledge Coach 

Welcome to 2018 Knowledge-Based Nontraditional Engagements for Knowledge Coach 

This Release Notes document provides important information about the 2018 release of Knowledge Based Nontraditional Engagements 
Please review this information carefully. If you have any questions, additional information is available on CCH Support Online. 

New in this Release  

Knowledge-Based™ Nontraditional Engagements 
 
2018 Knowledge Based Nontraditional Engagements can be installed on CCH® ProSystem fx® Engagement v7.5 by first installing the CCH 
ProSystem fx Engagement v7.5 and Knowledge Coach v2.5 August Update. The latest update can be downloaded here. This update will 
allow users to work on the 2018 Nontraditional Engagements title without installing ProSystem fx Engagement v2017.1.3 until your firm 
plans to update. 

This title is designed to help the auditor efficiently and effectively perform attestation engagements in accordance with applicable 
standards issued by the American Institute of Certified Public Accountants (AICPA), including Statement on Standards for Attestation 
Engagements (SSAEs). The Knowledge-Based Methodology for nontraditional engagements is a risk-based methodology conducting 
nontraditional engagements. It emphasizes using knowledge of the entity, subject matter, and suitable criteria to perform procedures and, 
when applicable, make risk assessments and recommendations in connection with an engagement.  

Conducting Nontraditional Engagements are often unique and complex, and require specialized accounting, and attestation knowledge. 
Conducting Nontraditional Engagements requires the exercise of the practitioner’s professional judgment. This edition includes specific up-
to-date guidance for Nontraditional Engagements and is published for the purpose of communicating, to users of the toolset, updates and 
enhancements included in the current version. This document is not, and should not be used as an engagement program to update the 
documentation of an engagement started in a previous version of this product. 

The methodology is presented in terms of its application for attestation engagements including: 

• Attestation Engagements 

– Examination-Level (General) 

– Review-Level (General) 

• Agreed-Upon Procedures Engagements (General) 

• Prospective Financial Statements: 

– Examination-Level Engagements 

– Review-Level Engagements 

• Pro Forma Financial Information 

http://support.cch.com/productsupport/
https://support.cch.com/updates/Engagement/patch75/patch75.aspx
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– Examination-Level Engagements 

– Review-Level Engagements 

• Entity's Compliance with Specified Requirements or the Responsible Party's Written Assertion 

– Examination-Level Engagements 

– Review-Level Engagements 

• Management's Discussion and Analysis 

– Examination-Level Engagements 

– Review-Level Engagements 

• Sustainability Information (New) 

– Examination-Level Engagements (New) 

– Review-Level Engagements (New) 

• Cybersecurity Risk Management Program (New) 

– Examination-Level Engagements (New) 

The forms and practice aids in the knowledge-based methodology will help the practitioner to perform the procedures necessary to 
complete the engagement in accordance with professional standards. The Knowledge-Based tools include documents, attestation 
programs, practice aids, correspondence, and example reports. 

Although the KBA approach provides a framework for applying attestation standards, it is not a substitute for knowledge of professional 
standards and the exercise of the practitioner’s professional judgment and professional skepticism. The practitioner may need to refer to 
additional resources to determine how to apply the applicable standards to unfamiliar or unique circumstances. 

This document is published for the purpose of communicating the updates and enhancements included in the current version to users of 
the toolset. This document is not, and should not be used as an audit program to update the audit documentation of an engagement 
started in a previous version of this product. 

If you are updating from a previous version of this title, refer to the Knowledge Coach User Guide Chapter 12. The guide is found on the 
Engagement File Room Help menu.  

The 2018 documents include CCH® Accounting Research® material links to specific guidance that provides instant access to detailed analysis 
related to the steps and processes discussed in the workpapers.  

2018 Edition of Knowledge-Based Nontraditional Engagements  
This edition features numerous enhancements, including:  

• New: Examination-Level Engagements on Sustainability Information 

• New: Examination-Level Engagements on an Entity’s Cybersecurity Risk Management Program 

• New: Review-Level Engagements on Sustainability Information 

• Reorganizing and rewording columns in Relevant Principles and Points of Focus table of ATT-401 and moving the column to describe 
the control deficiency to the end for better documentation flow.  
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If you select “No” in the following columns, your control deficiency documented in the last column will flow to the conclusion 
section:  

– Are the Relevant Principles or Points of Focus Present? 

– Are the Identified Controls Effectively Designed and Implemented? 

– Do Compensating Controls Adequately Reduce the Risks of Material Misstatement? 

– Are the Relevant Principles Functioning for this Component of Internal Control? 

• In ATT-401 adding an “N/A” option to the “Are the Relevant Principles of Points of Focus Present?” column to the “Points of Focus” 
rows ONLY. The user could document the points of focus as not applicable, and the user will not respond to any other columns for 
that particular row as the diagnostics will clear. The user should focus on the functioning of the relevant principles as not all of the 
points of focus are required or applicable. 

• Removing user options in the “System Change Controls” column of the “Less Complex IT Structure” table of ATT-402.  

• Reorganizing and rewording columns in the “More Complex IT Structure” table of ATT-402 and moving the column to describe the 
control deficiency to the end for better documentation flow.  
If you select “No” in the following columns, your control deficiency documented in the last column will flow to the conclusion 
section:  

– Are Controls Present? 

– Effectively Designed and Implemented? 

– Do Compensating Controls Adequately Reduce the Risks of Material Misstatement? 

– Are Control Functioning? 

• Reorganizing and rewording columns in the “Activity-Level Control Objective” table of ATT-40X series and moving the column to 
describe the control deficiency near the end for better documentation flow.  

– If you select “No” in the following columns, your control deficiency documented will flow to the conclusion section:  

▪ Are Controls Designed Effectively? 

▪ Are Key Controls Implemented? 

▪ Do Compensating Controls Adequately Reduce the Risks of Material Misstatement Created by the Deficiency? 

▪ Are Control Activities Functioning? 

– Also, if you select “Partially” in column, Are Controls Designed Effectively, the control deficiency documented will flow to the 
conclusion section. 

• Adding the functionality to allow users to insert custom rows anywhere in the subprocess table in ATT-40X series. 

• Revising and Reorganizing KBA-501. This workpaper will reset on roll forward. 

• Adding a “Maximum” and “Slightly Below Maximum” option in AID-702, planned control reliance column. 

• Adding a new flow of information from KBA-200 to KBA-501 regarding the criteria being used for measurement and evaluation of 
subject matter. 

• Many new documents in this title as follows: 

– AID-914 Report Preparation Checklist: Review-Level Attestation Engagement on a Cybersecurity Risk Management Program 
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– ATT-114 Overall Attestation Program: Examination-Level Engagement on Sustainability Information 

– ATT-115 Overall Attestation Program: Review-Level Engagement on Sustainability Information 

– ATT-116 Overall Attestation Program: Examination Level Engagement on Cyber Security Risk Management Program 

– ATT-412 Evaluation of Management’s Description of the Entity’s Cybersecurity Risk Management Program 

– KBA-904 Basis for Inherent Risk Assessment: Cyber Security 

– COR-208 Engagement Letter: Examination Engagement on Cybersecurity Risk Management Program 

– COR-913 Representation Letter: Examination-Level or Review-Level Engagement When Reporting On Subject Matter 
information and the practitioner is reporting directly on the subject matter. 

– COR-914 Representation Letter: Examination-Level or Review-Level Engagement When Reporting On Assertion 

– COR-915 Representation Letter: Examination-Level Engagement on a Cybersecurity Risk Management Program 

– RES-020 Examination-Level Engagement on Cybersecurity Risk Management Program: Illustrative Program Description 

– RES-021 Examination-Level Engagement on Cybersecurity Risk Management Program: Illustrative Management Assertion 

– RES-022 Trust Services Criteria 

– RPT-941 Prospective Financials Engagement: Unmodified Opinion on Forecast Financial Statements That Contain a Projection 

– RPT-942 Prospective Financials Engagement: Unmodified Opinion on Partial Presentation of Forecasted Information 

– RPT-944 Examination Engagement: Unmodified Opinion—Report Expanded for a Financial Feasibility Study 

– RPT-945 Examination Engagement: Unmodified Opinion on Partial Presentation of Projected Information 

– RPT-1010 Examination Engagement: Unmodified Opinion on Subject Matter - Entire Sustainability Report 

– RPT-1011 Examination Engagement: Unmodified Opinion on Subject Matter -Specified Indicators 

– RPT-1012 Examination Engagement: Unmodified Opinion on Subject Matter - GHG Emissions Information 

– RPT-1013 Examination Engagement: Unmodified Opinion on Management's Assertion about Specified Indicators 

– RPT-1014 Examination Engagement: Unmodified Opinion on Management's Assertion about GHG Emissions Information 

– RPT-1015 Examination Engagement: Unmodified Opinion on Subject Matter - GHG Emissions Information; Practitioner Makes 
Reference to the Examination Report of an Other Practitioner on a Component Entity 

– RPT-1016 Examination Engagement: Unmodified Opinion on Subject Matter - GHG Emissions Reduction Information Related 
to a Specific Project 

– RPT-1017 Examination Engagement: Unmodified Opinion on Management's Assertion about GHG Emissions Reduction 
Information 

– RPT-1018 Examination Engagement: Qualified Opinion on Subject Matter - GHG Emissions Information 

– RPT-1019 Review Engagement: Unmodified Conclusion on Subject Matter - Entire Sustainability Report 

– RPT-1020 Review Engagement: Unmodified Conclusion on Subject Matter -Specified Indicators 

– RPT-1021 Review Engagement: Unmodified Conclusion on Subject Matter - GHG Emissions Information 
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– RPT-1022 Review Engagement: Unmodified Conclusion on Management's Assertion about Specified Indicators 

– RPT-1023 Review Engagement: Unmodified Conclusion on Management's Assertion about GHG Emissions Information 

– RPT-1024 Review Engagement: Unmodified Conclusion on Subject Matter - GHG Emissions Information; Practitioner Makes 
Reference to the Review Report of an Other Practitioner on a Component Entity 

– RPT-1025 Review Engagement: Unmodified Conclusion on Subject Matter - GHG Emissions Reduction Information Related to 
a Specific Project 

– RPT-1026 Review Engagement: Unmodified Conclusion on Management's Assertion about GHG Emissions Reduction 
Information 

– RPT-1027 Review Engagement: Qualified Conclusion on Subject Matter - GHG Emissions Information 

– RPT-1030 Examination Engagement: Unmodified Opinion on an Entity’s Cybersecurity Risk Management Program 

– RPT-1031 Examination Engagement: Unmodified Opinion on an Entity’s Cybersecurity Risk Management Program that 
Addresses only the Suitability of the Design of Controls Implemented within the Entity’s Cybersecurity Risk Management 
Program (Design-Only Report) as of a Point in Time 

– RPT-1032 Examination Engagement: Modified Opinion on an Entity’s Cybersecurity Risk Management Program (Description) 

– RPT-1033 Examination Engagement: Modified Opinion on an Entity’s Cybersecurity Risk Management Program (Deficiencies 
in Controls) 

– RPT-1034 Examination Engagement: Qualified Opinion on an Entity’s Cybersecurity Risk Management Program (Scope 
Limitation) 

Click here for the 2018 Nontraditional Engagements Title Overview for Knowledge Coach Users. 

In addition, forms and practice aids throughout have been updated to include new examples and tips, and where applicable, to take into 
account: 

New literature, standards, and developments, reflected in the following current audit and accounting guidance:  

• Government Auditing Standards (GAGAS), 2011 Revision. 

• AICPA Audit Guide: Attestation Engagements on Sustainability Information (Including Greenhouse Gas Emissions Information) (As of 
June 1, 2017);  

• AICPA Guide: Reporting on an Entity’s Cybersecurity Risk Management Program and Controls;  

• AICPA Statement on Quality Control Standards (SQCSs) No. 8, A Firm’s System of Quality Control (Redrafted) (QC Section 10). 

• AICPA Statement on Standards for Attestation Engagements (SSAE) No. 18, Attestation Standards: Clarification and Recodification. 

Important Notes: 

• Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated. 

• If your Current Editor Knowledge Coach Microsoft® Word workpapers become read-only or crash, please do the following: 

– Keep the binder with the affected workpapers open. 

– Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers. 

 

http://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2018%20NTE%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
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System Requirements 

• This title requires the 2017 Financial Statement Base Title. The 2017 Financial Statement Base title MUST be installed with one of 
the following versions of CCH® ProSystem fx ® Engagement and Knowledge Coach.  

– Engagement v7.5.100.1223 and Knowledge Coach v2.5.100.1224 available through the CCH ProSystem fx Engagement v7.5 
and Knowledge Coach v2.5 August Update or later. To identify what version you are running, please go to the Help > About 
window within the application.  

– Engagement and Knowledge Coach v2017.1.3 or later. 

• A minimum of 4GB of RAM is required for optimal performance when opening and navigating through Knowledge Coach 
workpapers. 

License Requirements 

This title requires the Knowledge-Based Nontraditional Engagements license.  
Any user that does not have a license for this title will not be able to use Knowledge Coach functionality in workpapers.  

For more information on how to update your licensing, view How do I add or update CCH ProSystem fx Engagement Licenses? on our 
website.  

For more information on how to assign licenses, view How do I assign Engagement Licenses? on our website. 

Download Instructions 

If you are planning to use this title on Engagement v7.5 and Knowledge Coach v2.5, ensure you apply ProSystem fx Engagement v7.5 and 
Knowledge Coach v2.5 August Update or later to all machines including Admin servers and terminal servers before installing the title. 
Review the August Update release notes for more information on deployment. 

To download this title: 

1. Navigate to the Knowledge Coach Updates section of the Engagement Support Website.  

2. Select the Knowledge Coach Series. The series are arranged by title type, then industry. 

3. Click on the Download File link next to the title you wish to download. 

Note: On some occasions the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please change the 
extension of the downloaded file to KCP using all capital letters. 

You must install the 2017 Financial Statement Base title before installing the 2018 Knowledge Based Nontraditional Engagements.  

The Financial Statement Base title is also available on the Knowledge Coach Update Website.    

The Knowledge Coach Content Package (KCP) download is a proprietary file that must be installed from within Engagement. Save this KCP 
file to a location on your local drive, and follow the Installation Instructions below. 

Installation Instructions 

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within CCH ProSystem fx Engagement. 
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files. Please 
refer to the Engagement with Knowledge Coach Release Notes for any other system requirements.  

 

https://support.cch.com/kb/solution.aspx/sw3937
https://support.cch.com/kb/solution.aspx/sw3943
https://support.cch.com/updates/Engagement/patch75/Engagement%20and%20KC%20July%202017%20Update%20Release%20Notes.pdf
http://support.cch.com/updates/KnowledgeCoach
http://support.cch.com/updates/KnowledgeCoach
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After downloading the 2018 Knowledge Based Nontraditional Engagements, do the following: 

1. Launch the Engagement Workpaper Management application so that the Local File Room is displayed. Select Tools > Knowledge 
Coach Titles.  

2. The Knowledge Coach Titles window will be displayed.  

3. Choose Add Title.  

4. Browse to the title package file (*.KCP) that you previously downloaded from the Knowledge Coach Support Web site.  

5. Choose Open.  

6. The system will display a progress indicator while the title package is added. You will receive a message that the title has been 
successfully installed once the process is complete. 

To release a title:  

1. Select one of the Knowledge Coach titles in the list that has been added but is not yet released.  

2. Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to 
“Released.”  

Note: In the Engagement Admin module, add and assign a Knowledge Coach module and the applicable Knowledge Coach title license to 
staff before using the workpapers. 

Important: Once the 2018 Knowledge-Based Nontraditional Engagements title has been added and released, they will be automatically 
deployed to other staff members when they login to the “Office” location, or when they synchronize a binder that contains Knowledge 
Coach workpapers from this title.  

Online Permission Key 

Permission key files may be downloaded from our website or when adding or updating the new licenses within CCH ProSystem fx 
Engagement with Knowledge Coach v7.5 and higher. After updating the license file in the Engagement Admin module, licenses need to be 
assigned to the staff who will use 2018 Knowledge-Based Nontraditional Engagements. 

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.  

CCH® Accounting Research Manager® 

CCH’s Accounting Research Manager (ARM) is the most comprehensive, up-to-date and objective online database of financial reporting 
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written interpretive 
guidance.  

Available on ARM, the Knowledge-Based Nontraditional Engagements Guide helps you comply with the most recent professional standards 
and guidance for the conduct of Nontraditional Engagements and to integrate the use of practice aids, tools, and other resources with its 
guidance. This publication supplements and complements the Knowledge-Based documents that are available in Knowledge Coach. 

If you subscribe to an ARM library that includes Nontraditional Engagements content, you can link directly to source material from 
Resources within Knowledge Coach documents. These links have been updated to refer to the accounting standards under the FASB 
Accounting Standards Codifications. Also, if you subscribe to the Knowledge-Based Nontraditional Engagements Guide on ARM, you can 
take advantage of references to the guide material from within the Knowledge Coach documents.  

https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
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With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about our 
content, our experts, and how you can request your free trial by visiting the Accounting Research Manager website. You can also access the 
Accounting Research Manager Web site by selecting Engagement > Binder Window > Shortcuts Bar > Guidance tab.  

Using Your Knowledge Coach Content 
To use your Knowledge Coach Workpaper Templates, do the following: 

1. Open a binder in Engagement. 

2. Select the workpaper tab into which you would like to insert the workpaper. 

3. Select New Knowledge Coach Workpaper from the toolbar or File menu. 

4. The New Knowledge Coach Workpaper dialog appears (Figure 1).  

5. Select the New Knowledge Coach Title with the content you would like to use. You can only select titles you have installed. The 
information displayed changes to reflect the workpaper organization available for the selected title.  

6. Select the Knowledge Coach Workpapers to insert into your binder, and click OK.  

7. In the Selected Workpaper Properties dialog, each workpaper name is automatically loaded into the Name field. Add a workpaper 
index in the Index field, and make any Name modifications you desire. You can also modify the tab location or the roll forward 
settings for each workpaper. 

8. Click OK. The integrated Knowledge Coach workpaper is now inserted into your engagement binder.  

Note: For more information on how to use Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.  

 

http://www.accountingresearchmanager.com/
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Figure 1 - New Knowledge Coach Workpaper 
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Additional Information on Knowledge Coach and the KBA Methodology 

Knowledge-Based Audit (KBA) Methodology 
Allows the results of one set of procedures to become the input for the next. The key components of the KBA methodology include: 
 

• An Overview that guides auditors through the methodology; 

• Knowledge-Based Attestation documents, integral to the risk assessment and overall audit processes, which contain steps and 
procedures required by professional standards; 

• Customizable Engagement Programs that take auditors through related steps and procedures; 

• Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Attestation documents and 
Attestation Programs; 

• Practitioner’s Reports that provide a variety of sample practitioner’s opinions on nontraditional engagements; and 

• Correspondence documents that provide sample letters to be used to comply with professional standards, SSAE and SSCS 
requirements and in many other common situations. 

CCH® ProSystem fx® Knowledge Coach 

Knowledge Coach functionality allows auditors to use the Knowledge-Based-Audit methodology more efficiently by eliminating the need for 
duplicate entry of the same information, tailoring audit documentation to each particular engagement, and documenting the link between 
risks identified and procedures performed. ATT-100 Tailoring Question is a document in Knowledge Coach that presents engagement-level 
questions designed to aid in tailoring the engagement documentation to fit each client. Completing the questions helps the auditor avoid 
duplication and unnecessary workpapers.  

Note: Before you begin your engagement, please review the guidance in ATT-101 through ATT-116 Overall Attestation Programs. This 
workpaper is intended to be your road map through a Knowledge-Based Audit methodology. You should start your audit with ATT-100 
Tailoring Question Workpaper and ATT-101 through ATT-116 Overall Attestation Programs. 

• Risks  
Can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-501 Summary 
of Risk Assessments. This allows the user to continuously assess risks during the engagement. Several workpapers prompt the 
consideration of the presence of risks, but the Risk Summary task pane must be used to document those risks. All documented risks 
flow to the Risk Summary. To ensure risks show in findings tables, make sure to check the “workpaper identified in” field of the Risk 
pane. 

• Information Flow  
Helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent information ensures that 
information and updates to information are not missed between workpapers. Drill-down functionality helps the user navigate 
quickly to the source of the information, aiding in the review of the engagement file. 

• Diagnostics  
Help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks or relevant 
assertions, missing workpaper, and more.  

• Links to Accounting Research Manager (ARM) 
If you subscribe to an ARM library that includes audit content, you can link directly to source material from Resources within 
Knowledge Coach workpapers. These links have been updated to reference to the accounting standards under the FASB Accounting 
Standards Codifications and the auditing standards issued by the AICPA. Also, if you subscribe to the Knowledge-Based 
Nontraditional Engagements Guide on ARM, you can take advantage of links to the audit guide material from within the Knowledge 
Coach documents. 

• Interpretive Guidance 
It is integrated into each Knowledge Coach template through the Tips view of each new task pane. Informational features include 
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Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more effectively and efficiently. You can also 
navigate from Resources within a document or the tip pane directly to CCH’s Accounting Research Manager and industry audit 
guides by simply clicking on the Reference.  

 
 
 
 
 

Download Description: 2018 Knowledge-Based Nontraditional Engagements  

Version: 

Engagement and Knowledge Coach v2017.1 or later  
OR 
Engagement v7.5 and Knowledge Coach v2.5 with Engagement v7.5 and Knowledge Coach v2.5 August 
Update or later 

2017 Financial Statement Base 

Release Date: March 2018 

File size: 18MB 

Approx. Download Time: 42 minutes at 56 kbps 

License: Full Version 

Platforms: Windows® 7, 8.1, 10 

Office: Microsoft® Office 2013 or higher required 
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